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Email accounts and email packages

Email

Email stands for electronic mail. It is the means of sending and receiving messages to one or many people connected to a computer network. Email uses an address (an email address) like postal mail (snail mail), but rather than a person delivering the message it is delivered via a computer network to the receiver’s computer. It is very fast (often instant), very cheap and allows easy internal communication within an organisation as well as external communication with anyone who has a connection to the Internet and an email account.

Standard features of an email package allow you to:

· receive and send email messages

· send the same email message to more than one person at a time

· send an email message and attach a number of files (such as image files or documents) to your message

· forward an email you have received on to another person

· copy one or more people in to an email message you send

· store records of people’s email addresses and other contact details in an Address Book.

Types of email accounts

There are basically two ‘types’ of email accounts. You might have a work email account as well as a personal email account. Your personal email account might be with one of the ‘free’ email services such as Hotmail, Yahoo!Mail, Email4Life or MailExcite. Work email accounts are restricted to employees of an organisation. These systems can be outsourced to a specialist email business or managed in-house and run on a dedicated email server.

Email packages
An email package is email account software, such as Microsoft Outlook. The interface that you use to access your email account will vary depending on the type of account you have (as discussed above). Work email accounts commonly use Microsoft Outlook, Outlook Express or Eudora programs. The other email services will use their own interface which you would generally access by visiting their website on the Internet.

For the purposes of this Learning Pack, we will be focussing on a work email account using an appropriate email package.

Structure of an email address

An email address is made up three parts: the name (or nickname or alias) of the person (sometimes the job title of the person); the @ symbol; the domain name where the person’s email account is maintained. Take Amy Smith’s email address smith@optusnet.net.au as an example. The three parts are:

1
smith (name or nickname)

2
@ (in every email address)

3
optusnet.net.au (the name of the Internet service provider or organisation where the person’s email account is held). 

Accessing email

Generally, your email account software (email package) is found on your desktop. To open the email package, double-click on the application icon.
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Figure 1: The Microsoft Outlook icon on a desktop
If the short cut for your email package is not on the desktop, you would need to go to the Start button, choose Programs and locate your email package, then click on the name of the email package to open it. 
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Figure 2: The Start menu

When the package is open you may need to enter your username and password to access your email.

Common features of email packages

Read and reply to messages in Inbox

When you first open your email package you are most likely looking for new mail received. This is located in your Inbox. Depending on how your email package is set up, you may have to choose your Inbox from a selection.

 [image: image3.png]Tasks. Messages

Inbox. 1
Orsfts
Outbox 0



Figure 3: Customise Outlook

Select Inbox from the list. You will then be shown the list of emails you have received.

[image: image4.jpg][ et o Fovres Toob acions b

| Gtiew - [ & | By X | @oreply Forenly ol 4@ Forverd | Fsend/Receive | ZoFind

Inbox .

¢ D[ [g|From | Subject [Received
&4 @ Ayling, Billie North Coast Institute ¥i... Tue 9/08/2005 10:35 AM
G Faler, Gray RE Cert I unit more mappi... Mon 8/08/2005 4:42 P
o Fakner, Gray RE: Mapping and title bar ... Mon 8/08/2005 3:15 PM.




Figure 4: Outlook Inbox — new messages, which have not yet been opened, are shown in bold
Depending on how the options for displaying your Inbox are set, you may see a preview of the actual message. The message has not yet been ‘opened’ though until you double-click on the envelope symbol beside the message.

When you do this you will see the content of the message on your screen, with a new menu and toolbar to allow you to action the message.

[image: image5.png][ Team meeting - Message (Rich Text) LRSI =Tk}

It % ow st Foma | oo ictens tip

| gorepty | orenlytonl | orowad | G [ v DY X & -9 - 2

From:  Raschepkin, Kin Sent: Mon 9/05(2005 11:34 AM
To:  Duggan, Caihyn
o

Subject;_Team mesting

i Caitlyn,

|Are you able to attend a tearm mesting today at 2pm?

Regards,
Kim

[Views expressed in this xessage axe thase of the individual sender, el are ot
Jcessarily the views of the NSW Departent of Edueation and Training





Figure 5: Contents of an email message — the contents of the message can now be seen, with a new menu and toolbars to allow you to act on the message

To reply to this message, you will click on Reply in the Toolbar. When you do this, you will be ready to write an email message to the sender.

Once you have clicked on Reply notice the email address (of the sender) is placed for you — now they are the recipient of your email message. Depending on the options set on your email package, the text of the original message may appear in the text area.
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Figure 6: Reply screen

Since the email address is already entered, and the subject line is already entered (with the word RE before it) you only need to write your message by clicking your mouse in the text area and typing. When you have done this you can click on the Send button to send the message.
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Figure 7: The text of the reply appears at the top of the screen

If you are using an email package other than Microsoft Outlook, you can look for tutorials under the Help menu of your program, or go to the Research section of this Learning Pack and find tutorials on accessing an mail message and replying to it.

Create and compose a new email message

OK. That’s fine if someone has written to you and you want to reply. What if you want to start the process by sending someone an email? 

1
Click on the New button.
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Figure 8: In Outlook the New button is in the top left-hand corner of the window.

2
When you click on New you will be presented with the following screen.
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Figure 9: A new message screen

3
In the To line you can type the email address of the person you are sending your email message to. For example, you might type smith@optusnet.net.au.

4
Enter the subject of your email in the Subject line.

5
Type your message in the text area. Finish your message with a ‘sign off’ of some description, eg ‘Regards’ + your name, your title and perhaps your organisation.

6
Always check your email message — edit it and spell check. 

7
Click on the Send button to send your message.

Using an Address Book

Alternatively, to enter an email address in the To line, you can click on the Address Book button on the toolbar and search for a person’s email address (if you have already set up an Address Book). For example, you would access the Address Book and type in a person’s name in the Type Name or Select From List box and this would retrieve that person’s email address and allow you to put this into the To line.
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Figure 10: Select names in Microsoft Outlook — click on a name or group list in the left window, then click on the To button to add the selected name/s to the To line of your new email message

Add an automatic signature

Having to record your sign off, name, title line and organisation line for every email your send gets a bit tedious. Let’s set up an automatic signature to take care of all that.

At the Inbox screen:

1
Choose Tools menu

2
Click on Options
3
Click on the Mail Format Tab
4
In the Send in this message format box, click the message format you want to use the signature with.

5
Click Signature Picker, and then click New.

6
In the Enter a name for your new Signature box, enter a name.

7
Under Choose how to create your Signature, select whether to start from scratch or use an existing signature. 

8
To select a file to base your signature on, click Use this file as a template and type the path and file name in the box, or click Browse to select from a list. 

9
Click Next.

10
In the Signature text box, type the text you want to include in the signature. Remember, you may want a title line (your job title), an organisation line (the name of your organisation) and perhaps a phone number.
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Figure 11: Use ‘Options’ under the Tools menu to change your email options
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Figure 12: ‘Mail Format’ tab with Signature Picker at the bottom of the window
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Figure 13: In the Signature Picker box, click ‘New’ to create a new signature
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Figure 14: Give the signature a name
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Figure 15: Click ‘Next’ and type the text for your signature and format as required

You can format the text in your signature by clicking on Font and Paragraph. When you are satisfied, click on Finish at this screen, then OK, then Apply at the Mail Format Tab, then OK at the Mail Format Tab. Check that the Use this Signature by Default entry holds your name, then check if the box is ticked beside Don’t use when replying or forwarding. Most people remove this tick so that your signature is included with your email message all the time.

Attach files to an email message

Attachments are files which you send with your email message. Unlike the text in your email message, the receiver will generally need to open or save the attachments on their computer to see the contents of these files. 

To attach a file to an email message:

1
Create your new message.

2
Compose the email in the usual way.

3
Click on the symbol for attachments (most commonly the paper clip symbol).

4
Browse to find the file you want to attach and click on this file to select it.

5
Click on Insert to insert the file you’ve selected and to return to the email.

If you want to attach further files, do the above steps again.

6
Spell check and edit the email.

7
Send the email.
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Figure 16: Choosing an attachment — choose the file you wish to insert from the list by clicking on it. Remember, you may have to change the Look in location. Click on Insert to return to your message.
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Figure 17: Attached files can be seen in the message area. Click on the ‘Send’ button to send the email with the attachments.

Note that when you have attached all the files you require, you will see them somewhere in your message. If they are interrupting the text of your message, drag and drop the files to the bottom of your message, generally after your signature.

Establish priority settings on an email message

In most email packages, three levels of priority settings can be made: High, Low and Normal. To give an outgoing message a priority setting:

In a new message screen:

1
Choose the View menu.
2
Click Options.
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Figure 18: The View menu, ‘Options’

3
In the Importance list, do one of the following: 

· To mark a message as very important, click High.

· To mark a message as not important, click Low. 

· To remove the importance level symbol from the message, click Normal. 
Notice, sensitivity settings can also be shown on messages.
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Figure 19: Message importance can be set at the top of this window

4
Click on Close to return to the message.

If you choose a high priority level setting, the red exclamation symbol on your email toolbar will be selected. If you choose a low priority level setting, the blue down arrow will be selected.
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Figure 20: The priority setting symbols in the toolbar

Forward an email message

To ‘Forward’ an email message means sending an email you’ve received on to a third person:

Original sender ( You ( Third person

This is very useful if another person also needs the information in an email message that you’ve received first. You don’t need to re-type the message, and if there are attachments with the message, the attachments will also be forwarded.

To forward an email:

1
Open the message.

2
Click on the Forward button.

3
Type in the email address for the person you are forwarding the message to, or insert their email address from the Address Book.

4
It is considered netiquette to make some note in the text area like ‘For Your Information’ (FYI) or ‘For Your Action’ if that is what is required.

5
Click on the Send button.
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Figure 21: The ‘Forward’ button — this takes you to a new message screen that has the original message copied into the message area. At the new message screen, type the email address of the recipient or insert it from the Address Book.
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Figure 22: Forwarding a message — it is courteous to type some comment like FYI or For Your Action in the text area

Create a carbon copy of an email

A carbon copy is something of an ‘old world’ term. In years past a typist would type a document and place a sheet of carbon paper between the original and a second sheet of paper, or sometimes a number of carbon sheets between several sheets of paper to make copies of the original. In the context of email, we create a carbon copy to send a copy to another person or persons. If we use the CC field (carbon copy) in the email header, the original recipient knows who else has received the copy. If we use the BCC field (blind carbon copy) in the email header, the original recipient does not know who else has received a copy.

In order to show the BCC field, you may need to turn it on by choosing the View menu, then clicking on BCC field.

Complete the email subject line and text in the usual way, then click on the Send button.

Some ‘rules’ about using email

For rules on Internet usage and email, you should refer to the Internet usage policy document in your workplace. Most organisations have such a policy document setting out guidelines in this area. Remember, following the rules is very important and the consequences of not doing this can often lead to dismissal and perhaps legal action taken against your employer or yourself.

As well as these rules, there is an acceptable standard of Internet usage, commonly known as netiquette. 

Netiquette guidelines

1
Remember at the final destination of your message there is a person. Although the medium is impersonal, your communication is not. You should not use speech that annoys, harasses or alarms other people.

2
When you are on the Internet you are in public. Adhere to the same standards of behaviour as you would in real life. That is, being ethical and law abiding. Become familiar with issues such as ethics and privacy.

3
Know your audience. Make sure the message you send is appropriate to the members of the group you are communicating with.

4
Do not waste other people’s time with irrelevant or unnecessary inclusions in your email. 

5
Don’t use all capitals (uppercase) in your message. Capitals are the equivalent of SHOUTING. They are also more difficult to read than mixed case.

6
Always include a subject line which allows the recipient to identify the contents of your message.

7
Keep your messages short, and make sure you leave a blank line between paragraphs. Don’t send messages that are pages in length —approximately 100 lines is considered the maximum length.

8
Clearly label any humour or sarcasm. Remember that without the cues associated with face-to-face communication it is easy to be misunderstood. Emoticons are often used to provide emotional clues, for example,  :)  is a smiley face denoting happiness,  ;-)  is a wink showing you are joking.

9
Read carefully what you send to make sure your message will not be misunderstood. Also check your spelling.

10
Include your name at the end of a message. You can do this as part of a signature. Keep this short and to the point.

11
Don’t send junk mail. It is annoying to receive this type of mail via the Internet as the recipient has to take the time to look at the message before it is discarded. It wastes time and is very inconsiderate. 

More information on netiquette can be found at: http://www.tafe.lib.rmit.edu.au/olg/netiquette.html
Common error messages

There are many error messages that may occur while you are using email. The most common error message is something like:

‘Your message did not reach some or all of the intended recipients.’

There are a number of causes for this message including:

· you have not entered the correct email address

· the person no longer holds that email account

· the computer where the person’s email account is maintained is not functioning

· your cabling (network) structure is not functioning

· you are not logged on.

The solution to this error message is to check the email address. Correct the address if necessary and resend the message.
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Figure 23: For an undelivered message, check the email address carefully

Summary

In this reading we’ve looked at what email is and why you would use it. We’ve developed some technical skills. These skills include opening and replying to an email sent to you, creating a new email message, and considering organisational guidelines when using email. We’ve seen how to create an automatic signature, how to attach files to emails, how to establish a priority setting for an email and how to forward an email and make ‘carbon copies’ of your email.

Terms used across different email packages are very similar. Though the screens shown here might not be exactly the same in your email package, by using the Help facilities in your package, or following the tutorials in the Research section of this Learning Pack, you will be able to find exactly how to do these things in your email package.

Check your progress

Now you should try and do the Practice activities in this topic. If you’ve already tried them, have another go and see if you can improve your responses.

When you feel ready, try the 'Check your understanding' activity in the Preview section of this topic. This will help you decide if you’re ready for assessment.
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